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Supported Browsers, Browser Settings and Troubleshooting
Problem using certain Browsers

Introduction

Purpose

This document will provide a list of the Browsers that can be used with HCOM, the necessary
settings for the Browsers and troubleshooting common problems that may be encountered
when using a certain Browser with HCOM.

Browsers

The recommended Browser when using HCOM is Internet Explorer (IE8 or le10). Chrome and
Firefox can be used. Sarari is NOT recommended.

Internet Explorer 8 or 10 Browser Settings
There are some common Browser Settings for both IE8 and IE10. One additional setting is
required in IE10. To set the Browser settings:

1. Open Internet Explorer. When unsure of the version of Internet Explorer running,

click on the Question Mark '®* icon on the Navigation Bar (when it does not
appear press the Alt Key and select Help) and select About Internet Explorer.

T = = Page~v Safety~ Took~|if=|

— [rterraet Explorer Help Fi

What's New in Intemet Explorer 8

o Crling Suppan

SChﬂﬂ |5 : Ahout Irtermet Explornes
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2. The About Internet Explorer window displays the version. Close the window.

e

‘it paws

Internet Explorer 8

3. Select Internet Options from the appropriate menu. When using IE 8, select
Internet Options from the Tools menu. When using IE10, select Internet Options

from the Gear “_ menu. Regardless of how Internet Options is selected - similar
windows appear with the same options except they may be displayed with a

different color and format.

v [] @ w Pagew Safe
& Diagnose Connection Problems...

L5 Reopen Last Browsing Session

=1 Pop-up Blocker
=Y Manage Add-ons

e Work Offline

k4 Compatibility View
Compatibility View Settings

[=#] Full Screen

Toolbars

Explorer Bars
<l Developer Tools
Suggested Sites

Send to Bluetooth Device...
Lync add-on
Send to OneMote

F11

F12

< 27 Internet Options

Print »
File »
Zoom (100%) 3
Safety »

Add site to Start Screen

View downloads Ctrl+)
Manage add-ons

F12 developer tools

Go to pinned sites

< Internet options >
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4. From the General Tab, select Settings under Browsing history.

General |Set:|.|rityI I Privacy I Content I Connections | Programs | Advanced

Home page —
‘/’ To create home page tabs, type each address on its own line.
L. »
S http://www.harvard.edu/ #

[ Use current ][ Use default H Use blank

Browsing history

’j_ Delete temporary filles, history, cookies, saved passwords,
¥ and web form information.

[ Delete browsing history on exit

C’“\ Change search defaults.

Change how webpages are displayed in
b

| tabs.

Appearance

Colors ][ Languages H Fonts ][ Accessibility I

5. Make sure the radio button of Every time | visit this web page is selected under
Check for newer versions of stored pages. If not, click on the radio button. Click

OK.

General | Security I Privacy I Content I Connections | Programs I Advanced |

H Temporary Internet Files and History Settings

Temporary Internet Files

Internet Explorer stores copies of webpages, images, and media
focts e

Check for newer versions of stored pages:

) Every time [ visit the webpage

() Automatically
() Never
Disk space to use (8-1024MB) 1 oy
(Recommended: 50-250ME)
Current location:

C:\Users\iim442\AppData'Local \Microsoft\Windows \Temporary
Internet Files)

I Move folder... ][ View objects ][ View files I

History

Spedfy how many days Internet Explarer should save the list
of websites you have visited.

Days to keep pages in history: 14 5

oK ancel

June 29, 2014, 2014

For Harvard Business Use Only

Page 3



gl
s

HARVARD
UNIVERSITY

HCOM

Supported Browsers and Browser Settings

6. To clear the Browser Cache, click on Delete under Browser history.

General |Securit\-I I Privacy I Content I Connections | Programs | Advanced

Home page -
I/? To create home page tabs, type each address on its own line.
L '3
l http://www . harvard.edu/ -

[ Use current ][ Use default ][ Use blank

Browsing history -

i ’J:_. Delete temporary files, history, cookies, saved passwords,
v ,-' and web form information.

[] Delete browsing his

Search

p- Change search defaults,

Tabs - =
Change how webpages are displayed in
1 tabs.

Appearance

Colors ][ Languages H Fonts ][ Accessibility ]

oK ][ Cancel ]

7. Make sure the boxes of Temporary Internet Files, Cookies and History are checked

(others can be selected) and then click Delete.

Internet Cptions

Delete Browsing History A —

[7] Preserve Favorites website data

Keep cookies and temporary Internet files that enable your favorite
websites to retain preferences and display faster.

=
Temporary Internet files

_
Cookies _ >
it
History >
T ——— X -

[ Form data
Saved information that you have typed into forms,

[ passwords
Saved passwords that are automatically filled in when you sign in
to & website you've previously visited.

[] InPrivate Filtering data

Saved data used by InPrivate Filtering to detect where websites may
be automatically sharing details about your visit.

About deleting browsing hisﬁ- Delete .
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8. Select the Security Tab.

9. The Security setting of Enable XSS filter needs to be disabled for the Internet,

I Content I Connections | Programs | Advanced

I/‘ To create home page tabs, type each address on its own line.,
b '3
2 http:/fwww.harvard.edu/ 7

[ Use current ][ Use default ][ Use blank

Browsing history

: Delete temporary files, history, cookies, saved passwords,
¥ and web form information.

[ Delete browsing history on exit

Delete...

Search
i,;‘ Change search defaults.

Tabs

Change how webpages are displayed in

tabs.

Appearance

Colors H Languages ][ Fonts ][ Accessibility J

Intranet and Trusted Sites zones. Each is set by selecting the appropriate zone from
Select a zone to change the security settings. Select Internet and perform steps 8

through 10. Then select Intranet and perform steps 8 through 10. Then select

Trusted Sites and perform steps 8 through 10.

| General | Security |Privac~,I I Content I Connections I Programs I Advanced

Restricted
sites

This zone is for Internet websites,
except those listed in trusted and
restricted zones.

Security level for this zone

Custom
Custom settings.
- To change the settings, didk Custom level.
-To use the recommended settings, dick Default level,

Enable Protected Mode (requires restarting Internet Explorer)

[ Custom level... H Default level ]

[ Reset all zones to default level I
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10. Click on Custom Level....

| General | Security |Priu'aq-I I Content I Connections I Programs I Advanced

Select a zone to view or change security settings.

@ & v O

Internet  Localintranet Trusted sites  Restricted
sites

Internet

g This zone is for Internet websites,
except those listed in trusted and
restricted zones.

Security level for this zone

Custom
Custom settings.
-To change the settings, dick Custom level.
-To use the recommended settings, dick Default level,

Enable Protected equires restar rnet Explarer)
Custom level...

eset all zones to default level

11. Scroll to the bottom of the Security window. Locate Enable XSS filer, click on the
radio button of Disable and select OK.

I
Security Settings - Internet Zone E
— -

Settings

@ Disable -
e tna

= | Enable XS5 filter
®

() Enable

() Disable
@ Enable
) Prompt
:3& User Authentication
8 Logan
() Anonymous logon
@ Automatic logon only in Intranet zone
() Automatic logon with current user name and password |_|
(@) Prompt for user name and password e

4 1 | +

*Takes effect after you restart Internet Explorer

Reset custom settings

Resetto: | Medium-high (defoult v [ Reset.. |
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12. Select Yes on Warning! window that appears.

I

Security Settings - Local Intranet Zone

gg ~

Settings

() Disable

PY

*Takes effect after you restart Internet Explorer

Reset custom settings

Resetto: | Medium-ow (default) '] [ Reset... ]

13. Ensure that cookies are handled correctly by selecting the Privacy Tab.

Select a zone to view or change security settings.

| General | 590—'”( |Privwac5-I | Coi}nt I Connections I Programs | Advanced

@ & v O

Internet  Localintranet Trusted sites  Restricted
sites

W trustnot to damage your computer or
your files.
‘You have websites in this zone.

Security level for this zone

Custom

Custom settings.
- To change the settings, dick Custom level.

Trusted sites =
p
This zone contains websites that you

- To use the recommended settings, dick Default level.

[T Enable Protected Mode (requires restarting Internet Explorer)

[ Custom level... ][ Default level ]

’ Reset all zones to default level ]

oK ][ Cancel I

Apply
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14. Click on the Advanced button.

| General | Security | Privacy |Cor|tent | Connections | Programs | Advanced

Settings -

}Ts; settings, dick the Default button,

To set a standard privacy level instead of using custom

Custom

- Advanced or imported settings

[

Sites ] ’ Import M Advanced ] D Default

Pop-up Blocker
§ i Prevent most pop-up windows from Settings

InPrivate —

: ,fl[ ) Do not collect data for use by InPrivate Filtering

appearing.

[] Turn on Pop-up Elocker

Disable toolbars and extensions when InPrivate Browsin
starts °

[ 0K ][ Cancel J Apply

15. Make sure the check box of Override automatic cookie handling is checked. If not
checked, click in the box.

Advanced Privacy Settings

i%é

You can choose how cookies are handled in the Intemet
zone. This ovemides automatic cookie handling.

o Tookies

n'ide automnatic cookie handling
First-party Cookies Third-party Cookies
@ Accept @ Accept
i) Block () Block
() Prompt i) Prompt

[] Abways allow session cookies

OK || Cancel
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16. Make sure that the Accept radio button is selected under First-party Cookies and
Third party Cookies. If not, select them. Click OK.

T T

i

Advanced Privacy Settings

TET T

| You can choose how cookies are handled in the Intemet

@} zone. This ovemides automatic cookie handling.

Cookies
[¥] Ovemide automatic cookie handling

First-party Cookies Third-party Cookies
@ Accept @ Accept

() Prompt () Prompt

[] Abways allow session cookies

17. If using IE10 (if using IE8 skip to step 18), the Compatibility View Setting needs to
be set to display all websites in compatibility mode. Select the Tools menu when it
appears on the Navigation Bar. When it does not appear, press the ALT Key and
Select the Tools menu that appears on the Navigation Bar. Select the Compatibility
View settings.

lFiIe Edit View Favorites

Delete browsing history... Ctrl+5Shift+ Del

InPrivate Browsing Ctrl+Shift+P
Tracking Protection...

ActiveX Filtering

Fix connection problems...

Reopen last browsing session

Add site to Start Screen

View downloads Ctrl+]
Pop-up Blocker »
SmartScreen Filter 3

Manage add-ons

Compatibility View settings >

Subscribe to this feed...
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18. Check the box of Display all websites in Compatibility View. Click Close.

=

VTA You can add and remove websites to be displayed in
¥ Compatibility View.

Add this website:

Websites you've added to Compatibility View:

[ | Display all websites in Compatibility View
[ Download updated compatibility lists from Microsoft

Learn more by reading the Internet Explorer privacy statement

19. Click OK to save all the Browser settings.

(Ccmpatibility View Settings =

harvard.edu

| General | Security |Pri\c'aq-I | Content | Connections | Programs | Advanced

Select a zone to view or change security settings.

@ & v O

Internet  Localintranet Trusted sites  Restricted
sites

e
This zone contains websites that you

trust not to damage your computer or
your files,
You have websites in this zone.

Security level for this zone

Custom
Custom settings.
-To change the settings, dick Custom level,
-To use the recommended settings, dick Default level.

[C]Enable Protected Mode {requires restarting Internet Explorer)

[ Custom level... H Default level ]

[ Reset all zones to default level ]
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Chrome Browser Settings
Currently, there are not recommended settings for Chrome.

Firefox Browser Settings

Firefox Browser settings are set to handle Cookies appropriately when working in HCOM. To set the

appropriate Cookie settings:

=

1. Open Firefox. Click on the icon

right hand corner of the Browser window .

& Harvard Unnversity

=

€

2 Most Vated @ Getting Started

harvard.edu

Letest Headlines

mnm HA RVA R D About Harvard + Admissions & Aid ~

UNIVERSITY

EVENTS

The genesis of
genius

The Health Burden of
Stress: What We Can Do
About...

SAl Summer Film Series:
Pakeezah

FreeCycle at the Farmer's
Market

* B bowtosecocbiesinfe X B $

Schools ~

L

Resources & Oﬂin:

AMPAIGH

il

TINY BOOKS BY THE BRONTE CHILDREN SUGGE ST THE UNBOUNDED CREATIVITY TO COME

Explorations of human
disease: The bacterial
frontier -

designated by the 3 vertical lines in the upper

D
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2. Select Options.

(=207
T Harverd Unversity L+
¢ & harvard.edu ¢ B rowtostockiesn=l * B + A =
I8 MostVisted @ Getting Stated i) LatestHesdlins
- 100% +
eid HARVARD About Harvard + Admissions & Aid ~ E o ‘
= UNIVERSITY MHew Window  New Private Sive Page
Window
GAJTETTE NEWS EVENTS
-
- 0O @
Prirt Hestory Full Screen

New way to regrow | L LG\ *

Find Options Add-ons
human corneas
Developer

€) Signin to Sync

3 Customize e O

"'i, : " ;\‘ ™
SAl Summer Film Series: FreeCycle at the Farmer's The Health Burden of Explorations of human
Pakeezah Market Stress: What We Can Do disease: The bacterial
Thu, July 3 2014 % ADper Tue v B 201412 00per About.... frontier -

3. Select Privacy.
T Herverd University =
€ B @ haverdeds R0 = Jr—— *EB A =

2 Most Visted @ Getting Starte =

-
R
General  Tabs  Content  Apphcati

Tracking
Tell sstes that | do pot want to be tracked

5;? HARVA]

UNIVERSI

Resources & Offi 1

Tell sges that | want to be tracked

@ Dg not tell sites anything abouwt miy tracking preferences THE HARVARD CAMPAIGN

Learn More

Hestory
Firefox wilt | Remember hetory |
1] ll l]] a Il ( [ Firefox will remember your browsing, download, form and search hestory, snd

keep cockies from webies you visst

You may went to clear your recent history, or remove indnidual cockies,

Locstion Bar

When ysing the location bar, suggest | History and Bookmarks = |

Explorations of human
—n— disease: The bacterial

™ . 04 E e v @ 14 17 Ddpm About... frontier -
neas harvard.edu/ gasette/story/ 004/07/new-way-to-regrow-human- comeas/ 1 »
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4. Select use Custom setting for history from the drop down menu of Firefox will:

& Herverd University *

= = =

I L B horvardedu (0 ]

5 Most Visted @ Getting Starte ol - g N z 3
= . = 3
General  Tabs  Content  Applications Privacy Secunty  Sync Advanced

Tracking
=24 HARVAI Tell sites that | do ot want to be tracked
‘ o/ UNIVERSI Tel sifes that [ want te be tracked

@ Dg not tell sites anything about my tracking preferences

New wa
human ¢

You may want to clear your recent history, of remove indridual cookies.

Lecation Bar

When ysing the location bar, suggest '}hﬂy.\ﬂw ':

)14 12 O0pm About...

| news.harverd edu/gazette/ story/2014/07/new-way-to-regrow-human-comess/ |

i THE HARVARD CAMPAIGN

b3
i
-
»
]

Resources & Offi 1

Explorations of human
disease: The bacterial
lrontier -

5. Check the box of Accept cookies from sites.

| & Harvard Unteessity Wt

€ 2 harvard edu Opties '

& Most Visted @ Getting Start

-l = » F’ 3 .' * =

Tracking

Tell sites that | do pot want to be tracked

i HARVA]
o UNIVERSI Tll s that | wan 1 b tiackied
8 Dg not tell stes anything sbout my tracking preferences
Lesrn More

Hatory

Firefox wilk :Uuwnrm-ml'ahmnq =
New wa‘- Alwayt use private browiing mode

¥ Remember my browiing and download history

human ¢ :-----—-: -
Accept cookes from sdes | Exceptions... |

Ketp untit  they expite :ShouCnuhﬂ...i

Cleag history when Firefox doses afting

Locetion Bar
‘When yzing the location bar, suggest: :I-hawy.ﬂmh v

General  Tabs Content  Application: | Privacy  Secunty  Sync Advanced

Resources & Offi [

THE HARVARD CAMPAIGN

Explorations of human
—— disease: The bacterial
| Thes ke 3 BATE 8 S Ton @ 3514 12 00pm About... frontier -
news harvard.edu/ gazette/story/2014/07/ new-way-to- regrow-human-comeas’ 1 »
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6. Make sure Accept third-party cookies is set to always and click OK.

& Harvard University L
Ogtons = A P 8 4+ A =
- - 0 ;
- w! T" 2 \j &
General Tabs Content Applicstions Privacy  Security Sync Advanced

Tracking
oo HARVA Tell sites that [ do pot want to be tracked RCSOUI’CCSEE*Ofﬁr‘
e UNIVERSI Tall sites that | want to be tracked
@ Dg not tell stes anything about my tracking preferences i il THE HARVARD CAMPAIGN

Learn More
Hatory
Firefox will: | Use custom settngs for history =

New waj‘l Always uie pivate browiing mode

¢ Rememper my browning and download history

human ¢ = T T

Ketp

Clesg history when Firefex deses

Location Bar

‘When ysing the lecation bar, suggest | History and Bookmarks =

el Help
Explorations of human

-t disease: The ”Ctall&'
About... frontier -

1

news harvard edu/gezette/story/ 201407/ new-way-to-regrow- human-comeas/ 1

7. When you need to clear the Cache, click on the = icon.

[E=30C E
& Harvard Unnersity o h)

¢ il 2 harvard.edu * Bl howtostcockiesinfe & o B $ =

& Most Visted @ Getting Started 1 Latest Headlines

ﬁ:él! HARVARD About Harvard ©+  Admissions & Aid ~  Schools *+ Resources @Oﬂi-:
UNIVERSITY

ETTE NEWS EVENTS CONTACT HARVARL THE HARVARD CAMPAIGN

The genesis of
genius
Y

TINY BOOKS BY THE BRONTE CHILDREN SUGGEST THE UNBOUNDED CREATMITY TO COME

SAl Summer Film Series: FreeCycle at the Farmer's The Health Burden of Explorations of human
Pakeezah Markat Stress: What We Can Do disease: The bacterial
h 14, £ 1 About... frontier -
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8. Select History.

=
6 Harvard University -.ﬁ-l-
4 H 2 harvard.edu * - howtsmcwcckisinfe X o B O+ K =
& Most Vsted @ Getting Started ~ Latest Headlines
= 100% +
EEJ HARVARD AboutHarvard + Admissionsaid~- 1 %
o UNIVERSITY NewWindow  MewPivate  Save Page
Windo
GAZETTE NEWS  EVENTS
a(o) ¢
Print Hestory Full Screen

New way to regrow L O *

Fnd Options Add-ons
human corneas 3
FINDING S BY HARVARD ASFILIATED RE SEARCHERS COULD OVERCOME MAJOR CAUSE OF BLINDNESS Ouerslopes
€) Signin to Sync
3 Customize (7] V)

SAl Summer Film Series: FreeCycle at the Farmer's The Health Burden of Explorations of human
Pakeezah Market Stress: What We Can Do disease: The bacterial
h ¥3 2014, 5 0pm Tise i 41 About... frontier -

»
J

9. Make sure the box of Cache is select and then select Clear Now.

& Harvard University + [}

& B a harvard.edu e - howtostcockiesinfa P W B $+ @&

2 Mot Visted @ Getting Started 3 Latest Headlines

E;;‘ HARVARD About Harvard - Admissions & Aid ~ _ Schools ~ Resources & Offi 1
UNIVERSITY -

Clear All History
HE HARVARD CAMPAIGN

Time range to clear. | Evenythang

All sebected rems will be cleared.
d l_h Thes sction cannct be undone.

New way to re|
human cornea|

|~ Details

V| Browsing & Download History
¥ Foem & Sesrch History

¥ Cookies
FINDING S BY HARVARD-AFFILIATED RE SEARCH
¥ Cache

¥ Active Logns
Offline Website Data

V| Site Preferences

SAl Summer Film Series FreeCycle at the Farmer's The Health Burden of Explorations of human
Pakeezah Market Stress: What We Can Do disease: The bacterial
h t 145 30pn Tue 81 About... frontier -
.
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Troubleshooting Common Problems
Steps in troubleshooting problems experienced in HCOM using a certain Browser:

1. Some Browser updates (upgrades or new releases of the Browser - Mirosoft,
Firefox, or Chrome) may change your Browser settings and you should first check
that the appropriate Browser setting have been set and to clear the Browser
Cache.

2. Check here to determine whether your problem is described and perform the
recommended correction to the problem. If the error occurs again contact HUIT
Support Center at 617-496-2001 or via e-mail at ithelp@harvard.edu

All Browsers - Timeout
HCOM will time out

o With 30 minutes of inactivity and log you out of the application
e Or when Checking out of the Marketbplace even though 30 mininutes has not lapsed.

When you are logged off the system while shopping in the Marketplace with 30 minutes of
inactvity

¢ Finish shopping and attempt to Checkout and Submit to Oracle
e Logbackinto HCOM
o Access the Marketplace to perform Time Out Cart Recovery.
When time occurs during Check out (even though 30 minutes of inactivity has not lapsed
e Log out of Hcom
e Clear the Browser Cache

e Log back in and perform Time Out Cart Recovery.
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To perform timeout recovery:

1. Select the Shopping Cart on the left hand side of the window.

Shop / Shopping / Dashboard: / Shopping Home /

Catalog Search Everything = m J
Go to: advanced search | favorites | forms | Unlisted Rem Request | quick order  Browse: suppliers | categories | contracts | chemicals
Lab and Medical Supplies ?
Welcome to the HCOMarketplace!
Genlantis/Gene Therapy Systems has vWRe mms (3} lDT t‘(‘
notified us they cannot maintain current Vendor Partner Vendor Partner I p MB rezogen
peicing in their catalog sad has been Haneard Pricmg Harvard Pricing Harvard Pricing Harvard Pricing Harvard Pricing Harvard Pricing
removed from the HCOMarketplace. For all ) J )
Genlantis orders, please use a Non-Catalog
Request.
9 Sas curofing l) . 'S
b i e s o
For more information on the Firefox upgrade Harvard Pricing Harvard Pricing Hanvard Pricing Harvard Pricing
that can affect some punchouts, you can visit
this website. # - 4

BFS Daniels orders: Shoppers must not use

multiple cart sessions for BFS Damiels order Office Supplies/Books/Business Cards, Digital Print and Stationery ?
I a shopper goes 1o the punchout, creates an

tem, brings it back to the Marketplace or -

Oracle, then returns to make more items to w(l:lﬂi['lﬁ

add to the Marketplace or Oracle cart, only Vendor Partner E&1 Consortium Vendor Partner -
tha firet rart caccinn fame will ha raranad b " in n losasd MNaisian

2. Select My Carts and Orders.

oykewod 5] Go J
Dashboard
Shopping Home jers | categones | contracts | chemicals
Go Te ?
Advanced Search View Favorites  View Forms  Unlisted em Request
Quick Order o ]DT L
e —
e By Harvard Pricing Harvard Pricing Harvard Pricing
Suppliers Categories Contracts Chemicals
Request.
*2 curofing [ ks K
~ — A ALCPRCH
For more information on the Firefox upgrade Harvard Pricing Harvard Pricing Harvard Pricing Harvard Pricing
that can affect some punchouts, you can visit
this website. J 4 J
BFS Damels orders: Shoppers r .
multiple cart se for BFS Daniels order Office Suppli Cards, Digital Print and Stationery ?
I a shopper goes to the punchout, creates an
ftem, brings it back to the Marketplace or -
Oracle, then returns to make more items to
add to the Marketplace or Oracle cart, only Vendor Partner E&] Consortium i
tha firct rart caccinn #ame will ha raranad b e n -
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3. Select Time Out Cart Recovery.

Shopping

jers | categaries | contracts | chemicals

?
& IDT | &
Harvard Pricing Harvard Pricing Harvard Pricing
y
Réquest.
: o curofing I PerrYy »
~ e b A A ALORCH
For more information on the Firefox upgrade Harvard Pricing Harvard Pricing Harvard Pricing Harvard Pricing
that can affect some punchouts, you can visit
this website. - - -
BFS Daniels orders: Shoppers must not use
multiple cart sessions for BFS Daniels order Office Supplies/Books/Business Cards, Digital Print and Stationery ?
If a shopper goes to the punchout, creates an
tem, brings it back to the Marketplace or
L &
Oracle, then returns to make more items to 'uw Cb“;:." w(ié]l]i('ls
add to the Marketplace or Oradle cart, only Vendor Partner £&J Consortum Vendor Partner -
tha first rart cacsinn #ams will ha raraiad b . in - [T

4. Time Out Cart Recovery displays the last 5 orders made within the Marketplace. Locate
the timed out Cart to recover. Continue the Checkout in HCOM by clicking on resubmit
cart.

W Shop My Carts and Orders  Time Out Cart Recovery =

Time-Out Cart Recovery. NOTE: Only use this page after encountering a time-out Oracle error. ?
Stat, — Mequizition Name Requisition Date/TIme T —
v 43967816 2013-10-07 01802743 01 10/13/2013 301 PM 65.55 USD resubmit :aD
a5 2013-09-05 01802743 01 9/5/2013 10:11 AM 79541 UsD .24
v 42037095 2013-08-04 01802743 01 8/4/2013 8:15 AM 45960 USD resubmit cant
v 41598777 2013-07-19 01802743 01 7/19/2013 9:40 AM 45960 USD resubmit cart
v 41334272 2013-07-11 01802743 01 7/11/2013 10:12 AM 52580 UsSD resubmit cart
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Common Time-out Problem Scenario when using IE8 or IE10

Problem: HCOM sometimes gives the Time-out message when retrieving a saved Cart when
using IE8 or IE10, even through the user did not have 30 minutes of inactivity while in the
Marketplace.

Correction: Perform the following:
1. Clear the Browser cache by:
e Selecting Internet Options
o Selecting Delete from the Browser history section

e Ensure that the boxes of Temporary Internet files, Cookies and InPrivate Filtering
data are checked and then select Delete.

2. Check and reset recommended Browser Settings for Internet Explorer for the version
installed on your machine:

e Make sure the radio button of Every time | visit this webpage under Check for
newer versions of stored pages

e Ensure that XSS filter is set to disable for Internet, Intranet and Trusted site

e Make sure that cookies are handled correctly by ensuring that Override automatic
cookie handling checkbox is checked and that the Accept radio button is selected
under First-party Cookies and Third-party cookies.

Internet Explorer 8 or 10 Browser

There are a few known common problems experienced in both IE8 and IE10 and most are fixed
by setting Browser Settings and clearing the Browser Cache. One additional problem is
experienced in IE10 and is fixed by setting a Browser Preference setting. Common problem
scenarios that occur in both IE8 and IE10 are covered first and the additional problem scenario
in IE10 is then covered.
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Common Problems for both Internet Explorer 8 or 10 Browser

Common Problem Scenario 1
Problem: When you access another Web Page from the Vendor Punchout, the Security
Warning window may display as shown here.

Security Warning é

(8]
lﬂ Do you wanl 1o view only the webpage conlent that was delivered securaely?

This webpage contains content thal will not be delivered using a secure HTTPS
connection, which could compromise the securnity of the anlire wabpage

More Info e ] bo

Normally when this window displays, the response is always Yes. When Yes is selected, the
Web Page displays with limited information and when the page contains links to other pages,
they are missing. So when any link on the Web Page is selected, the Web Page displays with an

error - as shown here.

=t e —— ——— - Sr——

¢ R M - s sy B ]

l\' g

=

P

Correction: This problem is avoided by selecting NO on the Security Warning window. So the
best recommended practice while working in the HCOM Marketplace and when the Security
Warning window appears ALWAYS select NO.
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Common Problem Scenario 2

Problem: When Punchout is selected, the connection to the Vendor Punchout fails without
notification. The spinning wheel symbol appears and indicator for the page loading does not
move.

¥ Punch-out - Windows Internet Explorer o e —
‘;. = &3 hitps sciquest.com 4 - B A | -
- . 3 - - -
EConven = B Select
= 4§ Search - | [ Share | More = Signin &, *
Favoriies 8 Pumeh-cut B -8 - W v Pagew Safetyw Tooks~ i~
Haryard Purchout | el P ool

C D

Correction: Check and reset recommended Browser Settings for Internet Explorer for the
version installed on your machine:

e Make sure the radio button of Every time | visit this webpage under Check for
newer versions of stored pages

e Ensure that XSS filter is set to disable for Internet, Intranet and Trusted site

e Make sure that cookies are handled correctly by ensuring that Override automatic
cookie handling checkbox is checked and that the Accept radio button is selected
under First-party Cookies and Third-party cookies.
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Common Problem Scenario 3

Problem: When Puchout is selected and after the connection is established to the Vendor
Punchout, the Vendor Punchout is asking you to log in. You should NOT have to log into the
Vendor Punchout as the Vendor should recognize you as a User.

# funch-cut - Wirkdow Brlernet Expiores - —— W - - _ e un,

m“ﬂ i SCRPAEEL LM b 4 it N apor o, - iy | 3¢ 1| 4 Google o -

X Wionen v B Selent
i Coogle = ) Search » [ Share  Movew Signln &,
o Faverites 4 Punch-out &-8- W - Bage Satety= Took+ i@

Harvard Puachou

Canll 1-B0-Wa'w - DL

@ Far Home For Wark Suppart Wy ACEcunt

Welcome to Premier

Support for Premier is one click away.

Gt Hitgps B 1

n

Aty pil Ty
Framiss (FOASES JOul GENEEBSN @ § CUSIITUTSA. SETNIN VI NS 107 [UPTTNG, PRGSO B PO St i
Eacced by 3 dedcated actoard an

Fushatrid. o a1 dodl dviibabie 147

[P | sphore Progwcs
l = I Obman getaled milsrmibion on products S50 kelsbsni 14 Tou Can expiont ot aplisrh $nd decde whals Seil ke
VUL BF LatIaN0s

Correction: Check and reset recommended Browser Settings for Internet Explorer for the
version installed on your machine:

e Make sure the radio button of Every time | visit this webpage under Check for
newer versions of stored pages

e Ensure that XSS filter is set to disable for Internet, Intranet and Trusted site

e Make sure that cookies are handled correctly by ensuring that Override automatic
cookie handling checkbox is checked and that the Accept radio button is selected

under First-party Cookies and Third-party cookies.
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Common Problem Scenario 4

Problem: When retrieving a Shopping Cart that was previously saved in the HCOM
Marketplace; the HCOM Marketplace displays a blank window as shown.

¥ Punch-cut - Wisdows Inteme Eapioesy e
. - i} ron BRSO * 3 LAk ML Y
o o P———
T omen = ISsen
= Semch « - Share | Mo Sign In &, -
Fovoiiter B Punch-out B - M v Pagew Saletyw Tgohiw g
[ Fams v Prams e

Correction: Check and reset recommended Browser Settings for Internet Explorer for the
version installed on your machine:

e Make sure the radio button of Every time | visit this webpage under Check for
newer versions of stored pages

e Ensure that XSS filter is set to disable for Internet, Intranet and Trusted site

e Make sure that cookies are handled correctly by ensuring that Override automatic
cookie handling checkbox is checked and that the Accept radio button is selected
under First-party Cookies and Third-party cookies.
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Common Problem for Internet Explorer 10 Browser

Problem: When accessing your HCOM Responsibility on the E-Business Suite Home page is
that all Responsibility folders are labeled with undefined.

U' £ https.//apolio33.cadm harvard.eduB700/0A_HTM
- - - = = | — S _— = - = = R = —e———— ——=m
s Favorites | iz 3 tracking-info - CustomW... @) Web Slice Gallery
@ Oracle Applications Home Page - v [ @M v Pagev Sefety~ Took~ @@~

ORACL.E' E-Business Suite

B2 Favorites ¥ Logout Help

Logged In As 01809784

Oracle Applications Home Page

Correction: Set the Compatibility View Settings for IE10.

Key Points when encountering problem in IE 8 or IE10

Key points when encountering problems in IE8 or IE10 with HCOM

When encountering problems in the HCOM Marketplace using IE8 or IE10, you should always
close the Browser when the problem occurs. Re-open the Browser - check all the Browser
settings and reset any that are incorrect. Clear the Browser Cache. Re-enter HCOM and
complete the task you were performing.

If the error occurs again contact HUIT Support Center at 617-496-2001 or via e-mail at
ithelp@harvard.edu.

Also remember that some Browser updates (upgrades or new releases of Microsoft) may
change your settings and therefore, you may need to reset the Browser Settings.
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Common Problem with Chrome

Problem: In using Chrome with the HCOM Marketplace, a problem occurs when Punchout is
selected and the Punchout Vendor Web Page displays a message that it is unavailable or hangs

when loading and the Security Shield © appears in the Address Bar as shown. This occurs as

the Browser pages are displaying in mixed content (HTTPS and HTTP).

PuncihOut X\
L C | £ httpsy/usertestsciquestoom/apps/ R h PunchoutFrameSet? RetumbUn« S 2Fapps¥2 FRouterfe2 FHome Bsupplier

Harvard Punchout

Buy Online or Call 1-B00-158-E11% T

Please wall while pour cusiomized Premier pags = paoed

Correction: Steps to correct:

1. Click on the Security Shield 9 .

i

L4

2. Select Load anyway or Load unsafe script (depends upon the version) and click Done.

= @ B
PunchQut K
+ 2 | B httpsy/usertestsciquestcomy/apps/Router/PunchoutFrameSet? ReturmU = % 2Fapps %2 FRouter®2FHome Asupplierld =4 [::,‘ =

Harvard Pusmchout 15 pagd includes s urauthendicatesd] sources

Lead wnsafe script

Buy Onling or Call 1-B00-358-873%

Please wail while your customized Premier page o loaced
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The Punchout will display with mixed content for this one session ONLY. The Address in the
Address Bar will have a red line through it and the indicating that mixed content is being
displayed.

[T
B = I
| -
<L Q' | [k bayE/ fusertest sciguestoom/apps/Router/PunchoutF rameSet? et Fapy FRouter Hiome plier 5 =
Harvard Punchout [ Canccd PaanchOut |
By Onling or Call 1-R00-188-873% Harvard University CAT

Camndiard Configuration: |

Premier Welcometo Premiers

' ik cha b hi B 0 Shap i
Soltecare & Peripherals Bast
CAIT Standard Sacura Hotebook Bundlas Sellers
C=oose Yom qur best-seling
Secured Sandard - eleciomcs, BE sccessones
[ — | Latitude ET440 14 i s ke plEE

Key Points when encountering problems in Chrome

Always check the Address Bar for the Security Shield icon '\ . Whenit appears, click on it
and select the option to Load the content.

If the error occurs again contact HUIT Support Center at 617-496-2001 or via e-mail at
ithelp@harvard.edu.
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Common Problem in Firefox

Problem: In using Firefox with the HCOM Marketplace, a problem occurs when Punchout is

selected and the Punchout Vendor is unavailable. The Security Shield @ appears in the
Address Bar as shown. This occurs as the Browser pages are displaying in mixed content
(HTTPS and HTTP).

* Insecure Website -

https://insecurewebsite.com

) ==

Correction: Steps to correct:

1. Click on the Security Shield & .
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2. The Security window informs you that the content of the page is being blocked. To
unblock the content, select Disable Protection on this Page from the Keep Blocking

menu that appears.

|

€

(—Free e

 Insecure Website

U

Firefox has blocked content that isn't secure.

Most websites will still work properly even when this
content is blocked.

Learn more

© @ httpsy//insecurewebsite.com

| Keep Blocking E]

I Disable Protection on This Page b

X  Not Now

The Punchout will display with mixed content for this one session ONLY. The Address in the
Address Bar will have a red line through it and the indicating that mixed content is being

displayed.
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Key Points when encountering problems in Firefox

1. Always check the Address Bar for the Security Shield icon \J . When it appears, click on it
and select Disable Protection on this Page from the Keep Blocking menu that appears.

2. Check the Browser Settings: Make sure that Cookies are handled correctly by selection
Options forthe = menu, selecting Privacy, select Use custom setting from Firefox will: and
check the box of Accept cookies from sites and make sure Accept third-party cookies is set to
always .

3. Make sure that the Cache is cleared: Select History from the = menu, make sure box of
Cache is select and click on Clear Now.

If the error occurs again contact HUIT Support Center at 617-496-2001 or via e-mail at
ithelp@harvard.edu.

Also remember that some Browser updates (upgrades or new releases of Microsoft) may
change your settings and therefore, you may need to reset the Browser Settings.
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